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Preferences

You can configure Nitro Pro 7 to customize the appearance, functions, updates and conversion settings to suit your workflow.

To access the preferences:

	
In the File menu, select Preferences


	
Navigate and change options in the two sections of the preferences dialog:

	
Categories of options, in the column on the left side. Use the + button to expand the list and show sub-categories.


	
Options for each category, on the right side







The preferences explained

Check for updates

You can set Nitro Pro 7 to automatically find and install updates periodically: Every day, Every weekly, or Every month. To disable automatic checking, select Never.

Commenting Pop-up notes

	
Font: Specify the default font for the pop-up notes and replies


	
Font size: Increases or decreases the font size of pop-up notes


	
Opacity: Specify the transparency level of pop-up notes




Commenting Printing & summarizing

The printing & summarizing options are related to the Summarize Comments and Summarize Comments and Print feature, found under the Review tab.

 

	
Sort comments by: Allows you to specify how comments will be sorted in the summary table, including location on the page, author, creation/modification times, and comment type


	
Font: Sets the font to use in summarizing comment information. This font will be used in both the comment callouts as well as the summary table


	Header text size: Sets the size of the header text. The header text is displayed across the top of each callout, as well as across the top of the summary table

	Body text size: Sets the size of the body text. The body text displays the comment contents in each row of the summary table, as well as the body of each comment’s callout

	Line style: Sets the line style to use in pointing from the summary callouts to the comment’s original location

	Page margins: Sets the size of the summary page margins. Large page margins provide more room for the callouts to be displayed, whereas small margins allow you to see a larger version of the original PDF page

	Print comment’s details: If set, the comments author, creation date and time will be included in the summary details

	Exclude pages containing no comments: If set, only those pages containing comments will be included in the summary. This can be particularly useful in summarizing large documents, since any uncommented pages will be excluded from the output file or print version, also resulting in faster processing time

	Add a border to the original page: If set, a border will be drawn around the edges of the original page, with summary information placed outside of the border

	Width: Defines the width of the comment boxes displayed on the right side of the page

	Height: Defines the height of the comment boxes displayed on the right side of the page



Conversion Extract images

	
Extract color images as: Save extracted color images as the specified file-type, or select Optimal for the images to be automatically saved to the most suitable format


	
Extract monochrome images as: Save extracted monochrome images as the specified file-type, or select Optimal for the images to be automatically saved to the most suitable format




Conversion Plain text

	
Plain text: Keep text in the same paragraph structure as the original document, or clear the structure and export text in lines of a number of characters which you can specify here


	
Headers and footers: Convert the text contained in the headers / footers of the original PDF, or exclude it from the conversion




 

 Conversion | Word & Rich Text Page layout

	
Highly editable (with layout): This option produces a file that is moderately editable, while still retaining the look-and-feel of the original PDF. Text formatting, graphics, and paragraphs are all recovered, and the output file is laid out in columns to maintain visual accuracy


	
Highly editable (single column): This option produces a file that is ideal for making major structural or layout changes to the document. Text formatting, graphics and paragraphs are all recovered, but no columns are used in laying out the content.


	
Precisely laid out: This option produces a file that accurately reproduces the look of the PDF, using text boxes to precisely layout content. This option can be used in circumstances where the visual quality of the file is of utmost importance, and only minor content edits are required….




 Conversion | Word & Rich Text Images

	
Automatic Anchoring: Automatically determine the best method for anchoring images, based on the type of content found in the PDF


	
Anchor to Paragraph: Images will be anchored to the nearest paragraph, making it easier to edit content since the image will move with the paragraph as the surrounding content is edited. Works well with the ‘Highly editable (with layout)’ layout option


	
Anchor to Page: An image will be anchored to a fixed location within the exported page, to precisely match the location of the image within the PDF page. Works well with the ‘Precisely laid out’ layout option


	Convert in-line images only: Only images placed between words and on the same baseline as line of text will be converted. Other images will not be

converted



 Conversion | Word & Rich Text Tables

	
Detect Tables: If set, content that is organized into tables within the PDF will automatically be detected and converted it to tables in the exported file




 Conversion | Word & Rich Text Headers and Footers

	
Detect and convert back to headers and footers: Automatically detect headers and footers, and will convert these into headers or footers in the exported file


	Detect and delete headers and footers: Content that appears to be header or footer information will not be included in the exported file

	Don’t detect headers and footers: Content that appears to be header or footer information will be converted as normal content, placed in the body of the exported document



 Conversion | Word & Rich Text Advanced Text Recovery

	
All text: Automatically detect headers and footers, and will convert these into headers or footers in the exported file


	Detect and delete headers and footers: Content that appears to be header or footer information will not be included in the exported file

	Don’t detect headers and footers: Content that appears to be header or footer information will be converted as normal content, placed in the body of the exported document



Conversion Advanced text recovery

	
All text: Apply an advanced optical text recognition technique to all text within the document


	
Just problem text: Apply an advanced optical text recognition technique to only the text in the document that requires it


	
Don’t fix problem text: Ignore any detected problematic text




 
	
NOTE: Advanced text recovery requires the installation of MODI. This procedure is documented in the Nitro PDF Knowledgebase. For more information, see: http://www.nitropdf.com/kb/Article.aspx?id=10261





Create PDF from HTML

	Display header and footer: If set, displays the header/footer that would appear on the printed HTML output

	Header Text: Override the default header text with your own. Internet Explorer print codes can be used here

	Footer Text: Override the default footer text with your own. Internet Explorer print codes can be used here



Create PDF from Microsoft Excel

	Convert links: Converts all active web links to active hyperlinks in the PDF file

	Create bookmark for each sheet: If set, a bookmark with the name of each sheet will be added to the PDF file

	Resize page to fit content: PDF page size will be resized so that all the content is visible on one page

	Include all sheets: All sheets will be included in the conversion to PDF



Create PDF from Microsoft PowerPoint

	Convert links: Converts all active web links to active hyperlinks in the PDF file

	Create bookmark for each slide: If set, a bookmark with the name of each slide will be added to the PDF file

	Frame slides: A border will be added around each of the slides in the PDF file

	Layout: Select how the slides should be presented in the PDF file



Create PDF from Microsoft Publisher

	Convert links: Converts all active web links to active hyperlinks in the PDF file



Create PDF from Microsoft Word

	Convert links: Converts all active internal and web links to active links in the PDF file

	Convert headings to bookmarks: If set, will use Word headings from the document to create a bookmark tree in the PDF file



Digital Signature Appearances

Your digital signatures can be easily customized to make just the information you want to share visible and used to display your physical signature, a corporate logo, or whatever other graphic you’d like to appear alongside your signature.

Digital Signature Time Stamp Servers 

For added security, digital signatures can include a timestamp from an independent, trusted authority. Nitro Pro 7 is able to utilize a timestamp server to help ensure that the timestamp is precise and secure, since the system clock could be modified by a user.

Forms

	Automatically calculate field values: A PDF form containing many complex and interdependent form calculations can affect how well a PDF viewer performs. If you use this kind of form regularly, or know you’re about to fill in such a form, consider turning off this preference

	Highlight form fields: A PDF form can be difficult for people to use as it is not always visibly clear what areas of the file must be filled in. When this preference is turned on, each time a form is opened in Nitro Pro 7, all form fields will display using a background color

	Highlight color: The color used when Highlight form fields is turned on

	Required field color: The color used to indicate fields that require completion wen Highlight form fields is turned on

	Form field double click: When designing forms, there are two different ways to access key properties and appearance settings: via the Properties context ribbon (located at the top of the screen), or via the Properties dialog (which opens as separate window). This preference allows you to choose which method will be used when you double-click a form field to edit it



General

	
Set as default PDF viewer: Specify Nitro Pro 7 as the default

program which will open when you double-click on a PDF document


	
Tell me if…: Nitro Pro 7 informs you when another program becomes the default viewer


	
Default page view: Specify the automatic page arrangement for reading PDF documents


	
Default zoom: Specify the default magnification for reading PDF documents


	
Hand tool can select text and images: Allows the Hand tool to select all types of document content


	
Select images before text…: if the document contains text and images that overlap, the image gets selected first


	
Copy text without formatting: Copies text to the clipboard without formatting characteristics


	
Copy text with formatting: Retains the text formatting when copied to the clipboard




Identity

	
Store your personal details, which can be automatically used to populate fields like the annotation details




Interface

	
Show extended tooltips: Shows detailed information about a tool when you hover over its button


	
Show explanatory text at the top of dialogs: Shows or hides the summary information which describes the function of a dialog


	
Show WebDav related information bar messages: Shows a message in the info-bar if network issues affect the opening and processing of the PDF file


	
Show information bar if document contains form fields: Shows a message in the info-bar when you open a PDF document with interactive form fields


	
Show information bar when JavaScript is detected, but is disabled in Preferences: Shows a message in the info-bar reminding you to enable JavaScript to access the scripted features of a PDF file


	
Show explanatory bar if document is certified: Shows a message in the info-bar when you open a certified PDF document


	
Show explanatory bar if document is secured: Shows a message in the info-bar when you open a PDF document which contains security restrictions


	Show font embedding related information bar messages: Displays information related to font embedding and usage when editing text

	
Color Scheme: Select a Blue, Black or Silver color scheme for the Nitro Pro 7 window, menus, and dialogs


	
Bookmark text size: Allows you to increase or decrease the size of bookmark labels in the Bookmarks Pane


	
Restore last view settings when reopening documents: When you re-open a PDF document, jump to the last viewed page, and adopt the last used zoom level. This setting is disabled by default, and overrides the Page View settings in the PDF document that specify the opening page.


	
Maximum number of documents in history list: Specify how many recently opened files to record page number and zoom information for, up to 25


	
Maximum number of documents in recently used list: Specify the number of documents, up to 10, listed in the File menu under Recent Documents




Internet Access

	
Let me specify a list of trusted sites: Grant or deny access whenever a PDF file attempts to connect to the Internet


	
Allow all websites: All PDF files are granted unconditional access to the Internet


	
Block all websites: Internet access is denied whenever a PDF file attempts to connect


	
Access to the following websites…: Enter the address of a website in, then click Allow to grant it unconditional web access


	
Edit: Select a website address in the exception list, then click Edit to modify the address


	
Delete: Select a website address in the exception list, then click Delete to remove the address from the list


	
Always ask: PDF files that attempt to connect to websites not in the exception list require your permission to connect


	
Block access: PDF files are denied access when connecting to any websites are not in the exception list




JavaScript

	
Disable JavaScript: Some PDF documents contain embedded JavaScript that can trigger security vulnerabilities. Select the Disable JavaScript checkbox to disable JavaScript for security reasons, or to abide by your company’s IT policy.




Plugin Manager

	
Plugin Manager: This list allows to you enable or disable plugin-extensions for Nitro Pro 7




OCR 

	Correct image skew: Straighten any text which is skewed on the document (usually due to a misaligned document during scanning)

	Use fixed threshold: Thresholding is the process of analyzing the histogram of an image to distinguish the text from the background. A fixed threshold applies the same cut-off point to the entire image, as opposed to finding the text dynamically. The percentage values indicate the point at which the contrast between blacks and whites is ideal to recognize text, with 0% being completely dark and 100% being completely white. This setting is recommended if an image contains different background colors, or a background which varies in shading or gradient. For more common OCR operations, it is recommended to disable the fixed threshold setting

	Detect text orientation: Rotate pages automatically when they have been scanned at 90, 180, or 270 degree angl

es

	Smooth color image: Flatten out the colors of the image to remove the JPEG compression artifacts and help recognition

	Language: Select the text detection language to use

	Quality:
	Low (fast): Ideally used when the text on the scanned document is very crisp and easy to recognize. This setting allows scans to be performed quickly

	Medium (medium): Recognition is more precise than the Low setting, requiring the scan to take slightly longer

	High (slow): Recommended for scanning text which is harder to recognize. Scan time with this setting is noticeably longer since the recognition methods are more complex




	Type:

	Downsample images: As a part of the OCR process, you are able to reduce the resolution of your scanned images to lower the size of the resultant PDF document. Downsampling will decrease readability of your document

	Image compression factor. The more an image is compressed, the smaller the file size of the output PDF



Units and Grid

	
Default units: Specify the default unit of measurement used by tools, for example, page margins


	
Show Grid: Show or hide a grid over the document viewing pane


	
Snap To Grid: When you reposition objects such as sticky notes and text, they can automatically line up with the nearest grid-line


	
Grid line color: Specify a color for the lines of the grid


	
Grid dimensions: Specify the dimensions of the grid




 
	TIP: You can change the unit of measurement for the Grid values by changing the Default Units setting, which is also in the Units and Grid section.
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